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Reference Guide
This is Commotion’s™ Reference Guide.  It contains instructions for using all
of Commotion’s™ commands and functions.  All of the entries in this guide
appear according to the layout of the user interface.  The Guide is divided into 13
sections: one for the Clip Window -- the window that shows your footage -- one
for each of the six pulldown menus, and six others for Commotion’s™ floating
palettes.
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Clip Window
Below is Commotion’s™ Clip Window, the window that shows a clip once it is
loaded.  Several useful and  important features can be controlled from this
window.

   Window Resize Button
The Resize button, which appears in the upper right corner of all Macintosh
windows, commands Commotion™ to show the entire frame at the present
zoom setting.  If at the present zoom setting the entire frame cannot fit on your
monitor, the window is sized to take up the entire monitor, and the zoom setting
is maintained.

   Collapse Button
The Collapse button appears on the upper part of the right edge of the Clip
Window.  It allows you to collapse the window into a small thumbnail view to
save screen space.  Clicking on the Collapse button collapses the window to the
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thumbnail and clicking on the thumbnail returns the window to its size and
location when it was collapsed.

   Clone Source Indicator
The Clone Source Indicator icon in the upper right edge of the clip window tells
whether the clip window is set as the present source for the Super Clone Brush.

   Zoom Value
A small Zoom Value window in the lower left corner of the Clip Window
displays the current zoom as a percentage of the 1:1 zoom setting (where 1
screen pixel displays one clip pixel).  You can change the zoom value by
selecting Magnify, Reduce, Variable Mag..., or 100% from the Window Menu.
You can also use a keyboard shortcut: Cmnd +/- for Magnify and Reduce,
respectively.  Clicking and holding down the mouse button brings up a display
of the actual canvas size (in pixels) and present color depth display for the clip.
The zoom commands are covered extensively in the Window Menu chapter.

If you click on the Zoom Value window and hold down the mouse button, a box
will appear in the lower left region of the Clip Window showing the resolution
and the color depth of the clip.

Not yet activated: You can also increase or decrease the Zoom using the
zoom tool.  See this tool under the Tools palette chapter

   Current Frame
The number to the right of the Zoom Value is the Current Frame number.
When you change to a new frame, the value in this window will update to reflect
the change.

   Onion Skinning Button
The Onion Skinning Button toggles the Onion Skinning option on and off.
Onion Skinning is a lower opacity overlay of the preceding (or following)
frames.  Also see the Onion Skinning Preferences entry in the File Menu and the
entry under the Mode Menu.
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   BG Button
The BG button toggles on and off (shows/hides) the background layer, according
to the options you set in the Assign BG window.  This is part Commotion’s™
simple but powerful compositing functionality.  See the Assign BG entry in the
Calculate Menu chapter for how to use this command.

   Display Mode
This region shows which color channel(s) is(are) being displayed.  You can
change the display mode by using the Mode<Display Mode pop-up menu or
using a keyboard shortcut: Cmnd-1,2,3,4 to show the Red, Green, Blue, and
Alpha channels, respectively.  You can also use Cmnd-0 to show the regular
RGB (full color) display, and press Cmnd-M to display a red overlay of the alpha
channel on top of the other channels you are displaying.

   Paint on Alpha Button
The Paint-on-Alpha button allows you to toggle between painting on the Alpha
channel and painting on the color channel(s) currently being displayed.  When
the option is on, the icon turns red.  You can also control this option by
selecting the Paint-on-Alpha command under the Mode menu.

Normal Window Features
The Clip Window also has the other regular features that appear in Macintosh™
windows.

   Drag Resize - You can change the drag-resize of the window

   Close Window - The Close-window button works, too.

   Scroll Bars -  You can use the scroll bars to navigate around the
frame if the frame does not fit entirely within the window at the present zoom
value.
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File Menu

New Cmnd-N
This command is used for creating a custom sized blank canvas.

After selecting the New command, a dialogue box appears.  The dialogue box
allows you to name the file, select the size of the canvas (in pixels), set the
number of frames in the clip, and choose the color depth.  Enter any of the
numerical values by clicking on the window and typing the number in that you
desire.  Select the color depth by clicking on the color depth bar and releasing
when the color depth you want is highlighted.  Note that you cannot paint in the
Thousands of Colors color depth; this depth is primarily for playback.
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Open Cmnd-O
This command opens a previously created movie or PICT file sequence.  Open
will bring up the standard Mac Open dialog box, with two extra options, Show
Preview, and Open Movies as QuickTime Movies.

• Show Preview  - Clicking on the Show Preview checkbox at the
bottom of the Open dialogue box toggles between showing and hiding a
thumbnail preview of the file highlighted in the display of files.  If a
preview thumbnail does not already exist, pressing the “Create” button
will create a new for the movie or PICT.

• Open Movies  - If you are opening a QuickTime movie, you have the
option of opening the file in a standard QuickTime window which will
allow you to play through the clip as you would in MoviePlayer.
Clicking on the “Open Movies as QuickTime Movies” checkbox turns
the option on and off.  If it is on, a MoviePlayer window appears
displaying the file.  If the option is off, you will get the normal “Load
Frames” dialog box to open the movie as a Commotion clip.

When you click on Open in the open dialogue box and the Open
Movies as QuickTime Movie checkbox is not checked, the Load
Frames dialogue box appears.  This dialogue box allows you to choose
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the frame range, scale value, canvas size, and subwindow for the clip to
be loaded.

Load Frames Dialogue Box
When you press Open in the Open dialogue box, the Load Frames dialogue box
appears, allowing you to set several options for the frames you load.

 
The Load Frames dialogue box contains the following options:

• Color Depth is adjusted from this menu.  This allows you to set the
color depth at which the clip is loaded.  The color depth setting
determines how many colors are displayed in your Clip Window when
the file is open.  Millions of Colors means that there can be 256
variations in each of the Red, Green, Blue, and Alpha channels.
Thousands of Colors means that there are 56 thousand color variations
possible.  You cannot paint on frames loaded at Thousands of Colors;
this mode is primarily for improved playback speed.  You can paint in
both 256 colors (an indexed color palette) and 256 grays modes.

 
• The Crop Window command will activate the SubWindow mode so

that you can work on only a section of the clip.(See Subwindow)

 
Subwindow - The subwindow function allows you to open just a
sub-section of a clip, manipulate it, and then save it back into its
original location in the file.  When you select Subwindow from the
Crop pop-up, a new dialogue box appears, allowing you to click-drag to
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create a box that will serve as your subwindow.  You can position this
box anywhere in the frame and make it any size.

• The Scale  command will scale the entire clip and the window.  This
changes the resolution of the image so that it fits on a smaller canvas,
allowing increased playback speed.

 
• Skip/Duplicate- this will allow you to either skip or duplicate

frames in the increment indicated.  Skip allows you to open every
second or third frame by entering 2 or 3 in the number box next to the
word ‘Frame’ (or you can skip a higher number of frames).  When
Duplicate is selected, the number box shows the number of times that
each frame is included in the Live Frames; for example, entering 3 in
the number box when Duplicate is selected will load and display all of
the frames you set to be loaded three times.

Open Random...
This feature allows you to load a series of still art frames to use as keyframes
while animating.  This command only works with PICT images.  When you
select this command, the standard Open dialogue box appears.  You open one
frame at a time by selecting the file in the window and clicking Open (or double
clicking on the file name).  The frame loaded and the Open dialogue box
reappears, allowing you to open another frame.  Open as many frames this way
as you want, then click Cancel.  Commotion™ loads the frames into one clip,
in the order you select them.  (The first file you select is the first frame in the
clip, and so on.)

Close Cmnd-W
This command closes the file (for QT movies) or sequence (for PICT’s) in the
active clip window.  If unsaved changes exist, you will be asked if you want to
save these changes.
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Save Cmnd-S
Save and Save As save the current clip in the file format that you select.
Commotion’s™ has a few special options for saving:  You can select the file
format from the Type pop-up menu.  If the current clip was opened as a
Subwindow, the Subarea checkbox in the lower left of the Save dialogue box
selects whether to save the clip back to its original location in the larger file.  If
unchecked, the clip will be saved as a new file or sequence of files, separate from
the original clip.  The Save Alpha checkbox selects whether to save alpha
channel of the clip.  If the box is unchecked, the alpha channel information will
be lost so that when the clip is opened in the future the alpha channel will be be
black.

Revert  [Inactive in present version of Commotion™]
Use the Revert command to restore an entire frame to its last saved or snapshot
version (Snapshots are intermediate “saves” that you can make while working to
make an additional "copy" which is saved as a temporary file on your scratch
disk).  When Revert is selected, a warning box appears asking whether you want
to revert to the last saved version of the file; all changes made since saving the
file are lost.

Print to Video
Print to video brings up a dialogue box that allows you to set a number of
options for the Print to Video command.  You can then play your clip on the
monitor with the rest of the screen hidden, so that only the clip itself is visible.
You can set to play the clip any number of times, add a set number of seconds
before and after the play sequence, and add a note to be displayed above your clip.

Preferences
When Preferences is selected, a pop-up menu appears with three entries: General,
Display, and Onion Skin.

• General - An dialogue box appears allowing you to select the Primary and
Secondary Scratch Disks from a pop-up menu.  The menu displays the local
disks.  Check boxes appear in the bottom half of the window allowing you
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to choose whether Virtual Frames and Undoable Film are on or off by
default.  Regardless of these settings, Virtual Frames and Undoable Film can
be switched on/off by selecting them from the Mode menu. (See the entries
in the Mode Menu chapter for more information on Virtual Frames and
Undoable Film.)

 
• Display  - The Display Preferences dialogue box allows you to set screen

behavior when using a monitor set to less than Millions of Colors and
when switching between clips of different bit-depths.  The Auto Color
Depth Adjust checkbox changes the monitor’s color depth display mode to
the color depth of the clip window, in order to optimize the speed of
updating the screen and playing back the clip.  The Dither on Lower Color
Depth Displays checkbox tells Commotion™ to use dithering to improve
the display quality of lower color depth displays.  This mixes the colors of
nearby pixels such that the image appears to have greater color variation
than it really does.

 
• Onion Skin  - Brings up a dialogue box that allows you to set the opacity

of the Onion Skin overlay as well as the number of previous and later
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frames to see.  Onion Skinning is a feature of Commotion™, also described
in the Mode Menu chapter, that allows you to display the current frame as a
translucent overlay on top of the preceding or following frame(s).  This
helps you to follow differences from one frame to the next.  You can also
set the color of the onion skin layer by clicking on the Color Onionskin
checkbox and clicking on the colored rectangle to the right to choose a color
with the color picker.

Print/Page Setup Cmnd-P for Print

[Inactive in present version of Commotion™]
The Print command allows you to print out individual frames to the printer
selected in the Chooser, under the Apple menu.  When the print command is
selected, the standard Mac Print dialogue box appears.  The Page Set-up
command brings up the standard Mac Page Set-up dialogue box, automatically
configuring Commotion to print ot the selected printer and allowing you to
choose the orientation, scale, and paper size for the file to be printed.

Quit
This quits Commotion™.  If there are unsaved changes in any open clips, you
will be asked if you want to save.
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Edit Menu

Undo Cmnd-Z
This command undoes the last change made in the active clip.  Only the last
change can be undone.  After you execute Undo, you can redo the changes by
selecting Redo, which appears instead of undo (and it obeys the keyboard
shortcut for Undo, Cmnd-Z).

• Undoable Film - Using Undo when the Undoable Film option is
enabled allows you to undo a process that affects a range of frames.  To
use Undoable film the Undoable Film option must be turned on in the
Modes menu.

• Paint to Undo Buffer - You can paint to the Undo buffer by
holding down Command and painting on the Clip Window; this
changes pixels on the frame to the way they would look if you used the
Undo command.
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Cut/Copy/Paste/Clear Cmnd-X/C/V
[Inactive in present version of Commotion™]
These commands work on an intraframe basis -- that is, they apply only to the
frame you currently see in the clip window.  Holding down the Option key turns
these commands into extraframe commands - making them affect the range
currently marked by the in-out markers.   Cut and Copy place the current
selection into the clipboard.  Paste pastes the selection into the currently active
Clip Window.

Selections
[Selections are stil l  in Heavy Development in this version of
Commotion™.  The headings about selections, below, show
basically how they will work when finished.]

Selections in Commotion are represented by crawling ants.  Any time a
selection is made, painting, image processing and calculation commands can be
performed only on the selected area; unselected areas are masked out.  The
Marquee, Lasso, and Magic Wand tools can be used to create freeform selections
in the Clip Window. (For information on selections, also see the Tools Palette
section of this manual.)  Additionally, the following commands can be used to
modify selections.

Select All Cmnd-A
Selects the entire frame as the selection.

None Cmnd-D
Clears the selection completely.  If you want commands to affect entire frames,
it is a good idea to hit Cmnd-D to make sure nothing is selected.

Hide Selection Cmnd-H
Toggles the outline (marching ants) of the selection on/off.  The selection
remains selected until you unselect it by clicking outside the selection with a
marquee or choosing Select None (Cmnd-D).
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Inverse Selection Shift-Cmnd-I
Changes the current selection to its inverse; the area that was unselected becomes
selected and the area previously selected is deselected.

Feather Selection Shift-Cmnd-F
This allows you to soften the edge of the current selection, so that changes made
by painting do not abruptly stop at the selection boundary.  Brings up a dialog
box for setting feathering values.  Feathering can be set to be Inwards, Outwards,
or Center weighted so that you can make sure changes affect the side of an edge
that you want to have affected.

Edit Clip
Edit clip has a pop-up menu with three options.  These allow you to modify
your clip by adding, deleting, or blending frames.  Each command on the Edit
Clip pop-up menu brings up a dialgue box with more options.

• Insert Frames - The Insert Frames command in the Edit Clip pop-up
in the Edit menu brings up the following dialog box.  This allows you
to add more frames to your clip.  The new frames will be inserted after
the current frame (as displayed in the Clip Window and the Player
Palette).  You can select the initial contents of the new frames from the
four options: White, Background color (as currently shown on the
Tools and Color palettes), Previous Frame, and Frame Blend (which
blends the pixels of the preceding and following frames).
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• Delete Frames - The Delete Frames command in the Edit Clip pop-
up in the Edit Menu brings up the following dialog box appears.
Frames will be deleted starting from the frame you are currently on.

• Blend Frames - The Blend Frames command in the Edit Clip pop-up
under the Edit menu brings up the following dialouge box that allows
you to blend frames together.
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Mode Menu

Color Depth
This command allows you to switch the color bit depth for the clip.  The color
depth represents both the range of different colors that can exist in your clip and
the amount of memory that is required to store the color information for each
pixel.

Most paint operations are optimized for “Millions” of colors, and painting is not
permitted in the Thousands of Colors mode ***(but is possible in 256,
grayscale, or bitmap).  Once you have changed the bit depth for a clip, the
Revert command and Magic Erase Tool will not be able to restore frames or
parts of an image.  You must create a new saved version or a snapshot at the
new bit depth in order to regain these functionalities.
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Display
This command allows you to change the display mode from RGB, or the Red,
Green, Blue or Alpha channels individually.  Each individual channel is an 8-bit
grayscale channel that represents one of the color components: Red, Green, or
Blue.  The Alpha channel, or Matte, is not a color component; it is an 8-bit
grayscale channel used for masking out certain areas of frames.

The following keyboard shortcuts are available to switch quickly between display
channels.

RGB  Cmnd-0

Red  Cmnd-1

Green Cmnd-2

Blue Cmnd-3

Alpha Cmnd-4

Overlay Matte Cmnd-M
In Commotion™ like in other image editing programs the Alpha channel – or
Matte – is a way to help you composite separate clips together.  The matte can
be used to specify what part of a foreground image is shown and what part is
transparent so that you can see through to a background.  The alpha channel is a
separate eight bit channel (along with Red, Green, and Blue).  You can invert
this channel easily, so it is generally not important to keep track of whether it is
black or white that shows the image or is transparent.  For your reference,
however, by default black shows the image and white is transparent.

Overlay Matte (Cmnd-M) allows you to superimpose the Alpha channel over the
RGB channels of the clip.  Commotion™ uses a default color of red, or a color
you choose with the Overlay Color command (not yet implemented).
When you turn on the Overlay Matte function, the colored overlay (red or
otherwise) is the part of the alpha channel that is black.  The overlay color does
not appear in the areas of the frame where the alpha channel is white.
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Overlay Color...
[Not currently implemented]

Choose the Overlay Color... command to set the color value and opacity level
for the overlay.  Selecting this option brings up a dialogue box in which you
can select both the color and the opacity of the matte overlay.

Auto Frame Spooler, formerly known as Virtual Frames
When on, this allows you to move beyond the current loaded frame range.
Commotion™ automatically loads into RAM additional frames of the clip as
you continue advancing the frames beyond those that are loaded into RAM.
When the Auto Frame Spooler/Virtual Frames option is off, stepping beyond
the end of a clip's Live Frames will loop you back to the first frame in RAM.

Gang Clips
[still  in development]

Commotion™ allows you to “gang” separate files together, which means that
open clips that are ganged together move together in time and their windows
update as you move forward/backward in time.  For example, if one window is
used as a source for cloning in another window, ganging these clips together will
cause frame 1 in the clone source clip to be cloned into frame 1 in the target
clip.  Frame 2 in the source window will be cloned into frame 2 of the target
clip, and so on.  When ganging is off, only the currently selected clip will
update.  In this case, cloning would only use one selected frame as the clone
source.  To establish whether clips are ganged together, turn the Gang button
on/off in the window of the clips.

Onion Skin
"Onion Skins" are lower opacity overlays of the current frame on top of previous
or following (currently only previous frames can be shown) frames
that are handy when doing frame by frame animation/painting.  In the Onion
Skin Preferences (File<Preferences) Dialogue Box, you can set the number of
onion skin frames and the opacity of overlay of the current frame.  (The Color
of Onion Skin is not included at present.) You also can set the
preferences so that the default for Onion Skinning is either on or off (see
OnionSkin, under Preferences in the File Menu chapter).
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Target Cross Hairs
When on, the target area for clone brushes will appear as a crosshair in the
window you are cloning from.  When off, no crosshairs appear

Undoable Film
When Undoable Film is on and a change is made to a range of frames, such as an
adjustment to the brightness using the Brightness/Contrast filter, the Undo
command in the Edit menu will undo the operation for the entire frame range.
When off, operations that affect multiple frame ranges cannot be undone.

Undoable film works by cache-ing to your primary scratch disk a temporary
backup of your files.  This procedure is repeated each time you make an
operation, so that at all times you can undo the last operation.  Only the frames
that you are about to modify are sent to disk, so performance will depend on how
many frames you are about to change.  This is different from the Restore
command (which restores to the last manually saved files or Snapshot).

Undoable film is disk intensive, as it is making multiple backups of many
frames as you work.  You may want to turn the option on and off (under the
Mode menu) as you work, relying on it before making an operation whose
results you are not certain you will like.

Watch Folder
When on, Commotion will periodically monitor the source files for your clips,
and update any new file within the loaded frame range as soon as it is changed in
the finder.  When off, files are updated in RAM only when explicit operations
are performed that require loading the image(s) from disk.

This mode is useful to dynamically update sequences of images as they are being
dropped or rendered to disk.  If a 3D application is rendering a range of files,
Commotion can be left open to automatically loop the rendered frames—as new
frames are finished, they will automatically be incorporated into the looping
clip.
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Calculate Menu
The Calculate menu contains many of Commotion’s™ mathematical functions
for duplication, backgrounds, flip/rotate/scale, and time manipulation.

Duplicate/Duplicate Matte
This command is used to duplicate channels from one clip to another or to view
a new clip.  The file and channel(s) selected from the source file are copied into
the file channels selected for the destination in the Duplicate dialogue box.
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Composite / Use BG Layer
The Composite command is useful for quickly establishing a relationship
between two clips for painting and/or compositing.

Composite
Selecting this command in the Calculate menu brings up a floating palette to
designate the Background Layer for the current clip, the transfer mode and related
opacity/channels for the composite, and the destination for the Composite.  You
can bring up this dialogue box by holding down Option and pressing the BG
icon at the bottom of the Clip Window.

• Matte Checkbox - The Matte checkbox selects whether to use the
matte from a source other than the foreground clip.  When the Matte
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checkbox is unchecked, the alpha channel of the foreground clip is used,
when applicable.

• Matte Pop-up - For the Matte Into and Matte Behind modes in the
transfer mode pop-up, it can be useful to use the alpha channel of a
separate clip, which can be selected with the Matte pop-up.  Click-
dragging on the pop-up menu allows you to select the clip to be used as
a matte for the background from the clips that are currently open.  To
use the alpha channel of a clip, the clip must first be opened, although
it is not necessary for particular frames to be loaded.  The file chosen in
the Matte pop-up is only used as the alpha if the Matte checkbox is
checked; otherwise the alpha of the foreground clip is used.

• BG Pop-up - Click-dragging on the pop-up menu icon allows you to
select the BG from the currently open Clips..

• Transfer Mode Pop-up - This pop-up menu in the upper right hand
corner of the Assign BG window allows you to select the Transfer mode
for compositing the foreground (FG) clip with the BG.  See the
Transfer Mode Pop-up listing below for details on each transfer mode.

• Opacity - When applicable to the transfer mode, dial in the opacity.
This has a slightly different function for different transfer modes; see the
transfer mode listings below for more details.

• Frame Lock Checkbox - The checkboxes below the Frame Lock
icon allow you to lock the current background frame for use as the
background for all frames [????] for both the clip selected as the matte
and for the clip selected

• Frame Offset [NOT YET IMPLEMENTED] - For both the clip
selected as the matte and the clip selected as the background, you can set
a frame offset so that a frame in the foreground clip has as its
background an earlier or later frame in the background clip. For
example, with a relative offset of 2, the frame number of the
background clip is 2 frames greater than the frame number of the
foreground clip.   This value will stay the same as you advance through
the frames.  A value of zero means that the background frame number is
the same as the foreground frame number.  (The frame number of the
active/foreground clip is displayed near the lower left corner  of the Clip
Window and in the middle of the Player palette.)
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Transfer Mode Pop-up

The Transfer Mode Pop-up in the upper right portion of the Composite window
specifies how pixels are combined between the background and foreground layers.
Each layer is normally opaque, so placing a background layer “behind” the
foreground will be invisible unless the foreground pixels are somehow combined
with the background pixels.  The selections in the Transfer Mode Pop-up
provides a variety of ways to place the background and foreground layers
together.  In each case, the operations are pixel-by-pixel, meaning that
corresponding pixels in the foreground and background layers  are used to
generate the resulting pixel.

• Blend - Blends the foreground and background together by giving them
a total opacity of 100% and dividing it between the two layers.  The
opacity slider on the Composite palette shows the opacity of the
background layer.  Moving this slider between 0 and 100% blends
between showing only the foreground and only the background layer.

• Add - For each pixel in the films specified, the values in each color
channel are added together.  The values are capped at 255 (the maximum
value for a channel) and are not scaled.  So if a pixel has a red value of
200 and green and blue values of 0 and it is added to a frame whose
corresponding pixel has a red value of 100, a blue value of 100, and a
green value of 0, the result will be a pixel with red = 255, green = 0,
and blue = 100.  Any time the sum would be greater than 255, the
result is set at 255.  When light pixels are added together, the result is
usually a white pixel.

• Subtract - For each color channel for each pixel, the foreground pixel
value is subtracted from the background value (BG - FG).  If the
background is generally darker than the foreground, Subtract will result
in a frame that is largely black.

• Lighter - This compares the values in each color channel and keeps
the higher value.  The result will generally be lighter than the original.
The colors will frequently be much different from the original, since the
lighter/darker comparison is performed for each channel.

• Darker  - This compares the values in each color channel and keeps the
lower value.  The result will generally be darker than the original.  As
with the Lighter mode, the colors will often be much different from the
original due to the channel-by-channel nature of the comparison.
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• Matte Into - This uses the alpha channel of the foreground or the
selected matte (see Matte pop-up, above) as a mask for the foreground.
The alpha channel masks out the foreground and shows the background.

• Matte Behind - This uses the inverse of the alpha channel of the
foreground or the selected matte (see Matte pop-up, above) as a mask
for the foreground.  In this case, the alpha channel masks out the
background and shows the foreground.  In other words, Matte Behind
applies the selected alpha channel to the background, whereas Matte
Into applies the alpha to the foreground.

• Multiply  - Multiplies each channel’s color values together.  This
generally yields darker pixels than you began with.

• Screen - Screen functions like Add in that the result is always a lighter
color.  Screen takes the values in each color channel and multiplies
their inverse (“inverse” meaning “255 minus the current value”).  Light
pixels screened against dark pixels result in light pixels.  This transfer
mode is usually more useful for black and white colored pixels, since it
often results in bizarre color changes for saturated colors.

• Difference - The Difference mode compares each channel’s value for
each pixel and subtracts the smaller value from the larger value; unless
the corresponding pixels in each layer are both black, there will be no
black pixels resulting from the Difference mode.

Destination Radio Buttons

To select the destination for the composite, click on the radio button for the
destination you want.  The four options appear along the bottom of the
Composite window.  Assign does not render a composition of the foreground and
background, but instead generates a preview on the fly, according to the settings
you give.  This allows you to see the effect of your changes without
permanently changing any files.  New Clip renders a composition (according to
your settings) to a new clip which is automatically opened when it is created.
To Disk renders the composite to disk (not to RAM) as a new file.  And Flatten
renders the composite into the current foreground clip, effectively flattening the
foreground and background layers into one clip.  For the three destinations that
create a composition (To Disk, New Clip, and Flatten), the pixels of the
foreground and background are combined using the transfer mode and settings
you in this window.  The command will be executed over the current In-Out
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frame range so that only the frames in this range will be affected (see In/Out
frame range in the Player Palette chapter).

Use BG Layer
If you have assigned a background without redering a composition (do this by
clicking the Assign radio button in the Composite window), selecting the Use
BG Layer command in the Calculate menu toggles between showing and hiding
the background, according to the options you have set in the Composite dialogue
box.  You can also show/hide the background by clicking on the BG icon at the
bottom of the Clip Window.

Invert Cmnd-I
Inverts the channels (RGB, R, G , B, A) of all pixels in the current in/out frame
range or selection area.  “Invert” means (255 - current value), so if the red
channel has a value of 4, then inverting will give it a value of 251.  To invert
only one of the channels (RGB or Alpha), first display only that channel by
selecting it from the Mode<Display pop-up menu and then select Invert from the
Calculate menu.

Math Pop-up

Selecting any of the options from the Math Pop-up menu brings up a dialog box
for performing calculation operations between the pixels in two currently open
clips.

The math functions perform calculations based on two existing clips.  For each
type of calculation (or mode, in After Effects™ and Photoshop™),
Commotion™ performs pixel-by-pixel operations on the two existing clips.
The easiest way to learn how the math functions work is to experiment with
them.  Many result in extreme coloring unless one of the original clips is
mostly black.  Screen, for example, is good for adding raindrops that exist in a
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clip against a black background, but screening together two clips containing
identifiable pictures will yield a very bright and washed-out image.

Below is a description of the mathematical operations Commotion™ performs
for each math mode.  All images in Commotion™ are stored in terms of RGB
color space and all image processing operations are performed in RGB color
space except for functions that refer explicitly to non-RGB terms such as hue,
saturation, brightness, lightness, and contrast.  When your color depth is set to
Millions of Colors, each pixel in each frame is described by an 8-bit (0 to 255)
value for each color channel -- red, green, and blue.  Each channel has a value
between 0 and 255.  The math modes perform operations on these channel’s
values.  When the color depth is set to Millions of Colors, each pixel also has
an 8-bit alpha channel for use as a matte.  The operations in the Math Pop-up do
not affect the existing alpha channel of either clip involved in the operation.

Many of these modes also appear in the Math Mode pop-up menu in the
Composite dialogue box and are described with the other functions of that
palette, under the Composite command in the Calculate menu.

• Add - Adds each color channel’s values so that the result for each pixel’s
Red, Green, and Blue channels is the sum of the values for the
corresponding channel’s values in the two original pixels.

• Add Over - I don’t know

• Subtract - For each color channel for each pixel, the Clip 1 pixel value is
subtracted from the Clip 2 value.  If the background is generally darker than
the foreground, Subtract will result in a frame that is largely black.

• Difference - The Difference mode compares each channel’s value for each
pixel and subtracts the smaller value from the larger value; unless the
corresponding pixels in each layer are both black, there will be no black
pixels resulting from the Difference mode.

• Blend - Blends the foreground and background together by ...????

• Lighter - Compares the values in each color channel and keeps the higher
value.  The result will generally be lighter than the original.  The colors
will frequently be much different from the original, since the lighter/darker
comparison is performed for each channel.

• Darker  - Compares the values in each color channel and keeps the lower
value.  The result will generally be darker than the original.  As with the
Lighter mode, the colors will often be much different from the original due
to the channel-by-channel nature of the comparison.
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• Multiply  - Multiplies each channel’s color values together.  This
generally yields darker pixels than you began with.

• Screen - Screen functions like Add in that the result is always a lighter
color.  Screen, however, multiplies the inverse of each color channel’s
values, which basically just means that light pixels screened against dark
pixels result in light pixels.

Flip Horizonal or Vertical
This command will flip the selection or frame area ??? on either a horizontal or
vertical axis.  This command is not keyframable.  Commotion™ performs the
operation over the In/Out frame range.

Rotate
This command will rotate the frames of a clip in the In/Out frame range.  A clip
can be rotated clockwise, counterclockwise or 180 degrees.  The rotated frames
will automatically be resized to fit within the window without cropping.  (In
other words, the dimensions of the canvas will be reversed automatically to fit
the frame.)

Scale [Inactive in present version of Commotion™]
Selecting Scale allows you to increase or decrease the size of the image in terms
of the width and length in pixels.  It affects the frames in the In/Out frame range
set in the Player palette.

Time Adjust...
Selecting Time Adjust... brings up the Frame Time Adjust window, which
shows the frame number (1st frame = 1, 2nd frame = 2...) of the frames in the
original order plotted against the frame number in the new order. It is probably
easier to think of the plot as representing the passage of time in the clip.  When



37

you open the window, the plot slopes upward from beginning to end (steepest in
the middle), which means that ‘time’ moves forward throughout the clip.  If you
change the curve so that a portion of it is sloped downward on the screen, the
downward-sloping portion represents movement backward in time.  The steeper
the slope, the faster the animation appears in the clip.  Extreme changes in the
time adjustment can make the clip’s animation appear choppy in playback
because there are a set number of frames from which to generate the new
animation.

• Play /Stop  - Clicking on the Play icon in the Frame Time Adjust menu
allows you to preview the new time settings.  Clicking on the stop icon
stops the playback.  This playback will occur at a limited speed, since
Commotion™ has not yet rendered the changes to a permanent clip.

• Original/New - The original and new frame numbers of a selected point
on the Time Adjust plot are displayed below the Play/Stop icons.  Clicking
at a point on the plot causes the original and new frames to be displayed for
that point.

• Point/Add Point/Delete Point  - When the point icon (the left icon of
the three point icons) is highlighted (by clicking on it), you can click and
drag the existing points on the plot.  You can add new points by clicking on
the Add-point icon and then clicking on the plot where you want a new
point.  Delete points by selecting the Delete-point icon and clicking on the
points you want to delete.  When you click OK, Commotion™ calculates
the new changes
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Hide Screen Cmnd-T
Hide Screen hides the screen except for the active clip, which is positioned in the
upper left corner of the monitor when the screen is hidden.  The Hide Screen is
toggled on or off with the Command-T keyboard shortcut, or with the menu
option.  The menubar is still available when the screen is hidden; click near the
top of the monitor and the menubar menus appear.

Animation Timing
This command is used to re-time frames in a clip based on tick marks similar to
those used in animation timing sheets.  The command will affect the entire
clip’s overall timing and redistribute existing frames.  When you select
Animation Timing from the Calculate menu, you will be prompted for the
number of new frames to create.

The “Animation Timing” window will appear.  Moving the long tick marks
below the line will establish new timing.  You can play the clip back and
preview these new timings without committing to the changes by hitting the
play/stop buttons in the window; these buttons behave the same as the play/stop
buttons in the Time Adjust window.  (The frame rate will be limited.)
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• Upper Ticks - Represent the consistent timing of the clip with the frames
distributed evenly.

• Lower Ticks - Represent the new distribution of frames.  Move these
left/right to move them earlier/later in time.  As you move the ticks around,
a number will appear above and below the line: the number below the tick
is the frame number of that tick (from the original clip timing), the number
above the line is the NEW frame number where the frame will occur.

• Initialize To  - Select one of the options to fill new frames you are
creating.

• White - fills the new frames with white

• Background color - fills the new frames with the background color as
displayed in the Tools palette and Color palette

• Previous Frame - fills the new frames with the same image as appears
in the nearest existing frame preceding each new frame

• Frame Blend - performs an operation to blend the nearest nearest
existing frames preceding and following each new frame.

• Play/Stop  - Buttons can be used to preview the clip at the new duration.
Only the timing will be previewed (no new frames from the Initialize To:
setting will be shown).

• Create - After previewing the timing a new clip is rendered by hitting the
Create button.
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Filters Menu
[Filters are still in heavy development.  The descriptions below
cover several of the filters that will be available soon.]

The Filters menu contains many of the image processing routines that
Commotion™ is able to perform, including color adjustments, keying, blurs and
sharpens, adding and removing noise, and others. Commotion™ also can support
third-party plug-ins.  These different filters are organized into pop-up menus
according to their category.  When you select a filter, a dialogue box appears,
allowing you to set options for the filter.  When you press OK to execute a
filter, it operates over the In/Out frame range that is set on the bottom of the
two slider bars in the Player palette.

Repeat Filter
Repeat Filter will re-execute the last filter command used with all its settings
intact.  A common use would be to run a filter on a limited in-out duration range
to test the results, and then change the in-out range and use the Repeat Filter
command to complete the filter on the rest of the frames in the clip.

Color Adjustment Filters

fix screenshot

Color Balance
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The Color Balance filter allows you to alter a clip’s overall Red, Green, Blue,
Hue, Saturation, and Luminosity values.  You can alter any or all of these
variables when you run the Color Balance Filter.  Commotion™ applies the
selected change to all pixels in all frames included in the currently set In/Out
frame range.

To use the Color Balance filter, select it from the Color Adjustment pop-up in
the Filter menu.  This brings up the Color Balance dialogue box, showing a
preview window of the filter’s effects and the RGB (or HSV) sliders for
controlling the amount of change in terms of the different variables.

Click on either the RGB or HSV radio button to select the color space in which
to make your adjustments; Commotion™ updates the sliders to agree with the
color space you select.  You can drag the triangles across the sliders to set the
amount of adjustment in each variable, or click on the number box to enter the
number numerically.  You can either increase or decrease the value in any of the
channels or HSV variables.

The preview window in the dialogue box shows all or a portion of the frame in
the clip window.  You can zoom in or out in this window by pressing the plus
(+) or minus (-) signs at the bottom of this preview window.  The numbers next
to the +/- signs tell the current zoom of the preview window relative to the clip
window.  The appearance of this preview window will change as you drag the
RGB/HSV sliders around to show you how the image will appear after you
render the changes.

The Full Frame Preview checkbox  ???????? selects whether you are also shown
a preview of the changes in the actual Clip Window.  If this is checked, you may
be able to get a better idea of the effect of the Color Balance filter’s changes, but
this can also slow down the process of setting the color balance changes, because
Commotion™ takes more time to create the preview.
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When you press OK, Commotion™ renders the changes you set to the frames in
the In/Out frame range

A few helpful definitions:

Brightness: the amount of light given off by a pixel.

Contrast: the difference in brightness between the lighter and darker
pixels in an image.

Hue: the wavelength of light (“color”) reflected from or transmitted
through an object.

Saturation: the strength or purity of the color, or -in other words - the
extent to which an object appears to be free of white light..

Luminosity: basically, the brightness of a pixel  (the difference between
brightness and luminosity is a detail reserved for color scientists)

Keys

fix this screen shot

Simple Keyer: Red, Green, Blue, and Luminance

The Simple Keyer allows you to create a matte based on a color key -- such as a
bluescreen or luminance matte.  The four types of keys that can be taken with
the simple keyer are blue, green, red, and luminance.(????)  You select the
Simple Keyer from the Keys pop-up in the Filter menu, which brings up the
Simple Keyer dialogue box shown below.
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Select the type of key you want to use from the Keyer pop-up at the top of the
dialogue box.  These different types of keys refer to how Commotion™
calculates the matte you want.  The blue keyer, for example, looks only at the
blue channel value for each pixel.  The luminance keyer looks only at the
luminance of each pixel, and not directly at any red, green, or blue.  (For more
information on channels and color space, see ...???)

•  Color Sliders

The two sliders in the Simple Keyer dialogue box allow you to set the threshold
value for whether the matte pixel is rendered black, white, or gray.  To change
these threshold values, click on the right or left slider and drag it to where you
want it.  Commotion™ looks at the value of each pixel and compares it to the
threshold values set on the two sliders.  Again, each type of keyer only looks at
one particular color channel (or luminance, which is not a channel, but is a
single color space variable).  The right slider sets the value above which the
matte is drawn white, and the left slider sets the value below which the matte is
drawn black.  If a pixel’s value is between the upper and lower threshold values,
it is drawn as a gray pixel in the matte; these grays vary gradually according to
where the value lies between the two threshold values you set.

Here are topics that will be covered soon:

• THERE IS A THIRD SLIDER, too.

The Spill slider sets the ‘softness’ value... I don’t know how to explain this at
the moment.

• Matte, Foreground, Background, and Comp

• Full Frame Preview

• Invert

• Matte Pop-up

• Rendering
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When you have the settings how you want them, click OK, and Commotion™
renders the matte for the frames in the In/Out frame range.

• Save/Load

You can also save and load keyer settings so that you can use a certain group of
settings more than once without having to write them down or remember them.
When you press Save, a Save dialogue box appears, allowing you to give a
name and location for the saved keyer settings.  The settings are saved in a
separate file.

When you press Load, an Open dialogue box appears, allowing you to select a
file with saved keyer settings.  When you have selected a file with keyer
settings, press Open and the settings are automatically loaded into the Simple
Keyer dialogue box.

Color Extraction

[There will be a description of this filter.]

Difference

The sliders in the Difference... dialogue box allows you to set the threshold
difference value in each color channel for deciding whether to include a pixel in
the matte.  The three sliders in the dialogue box represent the amount of
difference there can be in each channel before the pixel is included in the matte.
The matte is generated using these threshold values to compare the clip with the
clean plate, and the softness slider’s value is added in to make pixels that are very
close to the threshold level gray, so that there is some transition between black
and white

Move the sliders until you get an edge that is not too hard (no abrupt shift from
black to white).  The three slider values will probably be fairly close together,
though not necessarily

Color Suppresser

[There will be a description of this filter.]
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Blur

Commotion™ has a set of filters for blurring images.  The Blur and Gaussian
Blur simply take the image out of focus; the Blur filter blurs by a fixed amount
and the Gaussian Blur allows you to set the amount of blur numerically.  The
Blur White and Blur Black filters allow you to blur your matte???   The Motion
Blur allows you to create the illusion of motion by blurring in a certain
direction???

Blur

[There will be a description of this filter.]

Gaussian

[There will be a description of this filter.]
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Blur White

[There will be a description of this filter.]

Blur Black

[There will be a description of this filter.]

Fast Blur

[There will be a description of this filter.]
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Motion Blur

[There will be a description of this filter.]

Sharpen

The Sharpen filter allows you to sharpen you image by increasing the contrast
between pixels.  When you select Sharpen from the Sharpen pop-up in the Filter
menu (currently there is only one filter in the Sharpen pop-up), the Sharpen
filter dialogue box appears:
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Noise

Median

[There will be a description of this filter.]

Add Noise

[There will be a description of this filter.]
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Remove Dirt

[There will be a description of this filter.]

Average Frames

[There will be a description of this filter.]

Special

Custom Kernel

[There will be a description of this filter.]

BuildMin

[There will be a description of this filter.]

Max
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Other Filters

MinMax

[There will be a description of this filter.]

Plug-In Filter

[There will be a description of this filter.]
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Window Menu
The Window menu contains zoom functions and a list of toggles to show or hide
Commotion’s™ floating palettes.

Magnify and Reduce Cmnd +/-
Magnify and Reduce increase or decrease (respectively) the size of the view by a
factor of two.  For example, Magnify will change a view at 100% zoom to
200%.  These commands only change the way the clip is shown on screen; they
do not affect the data in the file.

Variable Mag...
This command opens a dialogue box that allows you to enter the zoom with the
keyboard as a numerical percentage.
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100%
This command sets the zoom to 100%, which means that each pixel in the file
corresponds to one pixel on screen.  Clips with a canvas size greater than the
pixel resolution of your monitor (832 x 624, 1024 x 768, etc) are still sized at
100%, so the screen displays only a portion of the screen.

Palette Show/Hide Toggles
The bottom half of the Window menu contains a list of Commotion’s floating
palettes.  These include the Tools, Player, Tool Options, Color, Rotospline,
Super Clone (Clone Source), and Info palettes.  Selecting these headings in the
Windows menu toggles between showing and hiding the coresponding floating
palette.

When you click to show a hidden palette, the palette appears in the last place it
was prior to being closed or hidden.  If you have the Macintosh Windowshade
function enabled, the floating palettes obey the windowshade function like other
windows.  You can also drag the floating palettes to move them like you can
drag other windows.  The palettes do not have functions for resizing and
scrolling, however.  When Commotion™ is the current application, the floating
palettes appear in front of all other windows, including the Clip Window.  When
Commotion™ is not the current application, the floating palettes are hidden.
(The current application is the application with a check by its name in the
pulldown menu in the upper right corner of your screen.)  The later chapters
detail the functions of each palette.
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Show Open Files
At the bottom of the Window menu is a list of the clips currently open in
Commotion.  Selecting one of these headings shows and activates the window of
the corresponding file.
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Commotion’s™ Floating Palettes
Commotion™ has seven floating palettes that operate much like those in other
high-end desktop digital effects programs.  Commotion’s™ palettes include the
Tools, Player, Tool Options, Color, Rotospline, Super Clone (Clone Source),
and Info palettes.  Each palette is described in detail in the following seven
chapters.  Here is a brief overview of each palette’s main functions:

• Tools  - The Tools palette contains Commotion’s™ brushes and other tools
for the cursor.  These include tools for making selections, such as the
Marquee and Magic Wand Tools.  Also included are various painting tools,
among them being the Paintbrush, Clone Tool, Eraser, and Burn/Dodge
Tools.  There are also the Grab and Zoom Tools for changing the way clips
are shown on screen.  Finally, the Tools palette displays the foreground and
background paint colors.

• Player - The Player palette allows you to play the current clip, advance
frame by frame, change the range of Live Frames, and change the In/Out
frame range.  You can also change the playing options so that the clip plays
either once through, looping, or repeatedly forward and backward and turn on
or off the Virtual Frames Loader option.

• Tool  Options - The Tool Options (Options) palette contains all of the
options for the tools selected in the Tools palette.  All of the painting tools
allow you to select different brushes, or create your own; ...not finiished
here

• Color - The Color palette contains a variety of functions for selecting
colors for Commotion™ paint tools.  These include sliders for different
color channels, a scratch pad for trying out colors and creating new ones, and
a palette of swatches to allow you to quickly select particular colors.

• Rotospline  - The Rotospline palette contains the tools that allow you to
create paths to define mattes.  You can create any number of rotosplines and
set a variety of settings for each one.

• Clone Source  - The Clone Source palette controls the source for
Commotion’s™ Super Clone Brush, a tool that allows you to copy parts of
images from one frame to another.

• Info - The Info palette displays information about the current pixel where
your cursor is located.  The palette displays the location of the pixel in
terms of horizontal and vertical pixels from the upper left corner of the
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frame.  It also displays the values in each color channel -- Red, Green, Blue,
and Alpha -- for the pixel.
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The Tools Palette

The Tools Palette controls Commotion’s™ functions for painting and making
selections.  You can click on any of the tools to make them active, and most of
the them have a keyboard shortcut.  In addition to the paint tools that appear in
virtually all painting programs – such as paintbrush, airbrush, and marquee –
Commotion™ has tools specially designed for painting and editing over time.
Most of the tools also have a set of options for customizing your painting; these
options appear at the top of the Tool Options palatte.

The Rectangular Marquee
[Commotion™ is not currently obeying selections as paint
boundaries.]

The Rectangular Marquee Tool is used to make rectangular selections.  By
pressing on the icon (or pressing M on the keyboard (case insensitive) and then
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clicking and dragging in the clip window, a selection is made.  A selection is a
temporary matte that allows changes to be made only withing the selected area.
Selections can be cut/copied and pasted, painted on, moved, filled, and filters and
calculations can be run on the selection.  Selections can be unselected by
clicking once with the marquee or Lasso tool outside of the selection area, or by
choosing Select None from the Edit menu (Cmnd-D).

 The Lasso Tool
The Lasso Tool is another tool for making selections.  After selecting the tool,
you can make a selection by clicking and holding down the mouse button while
drawing with the cursor the shape of the selection you desire.  When you release
the mouse button, any gap between the ends of the shape you have drawn is
connected by a straight line to finish enclosing the selection.

The View Window Tool
Activating this tool allows you to draw a rectangular window in the Clip
Window within which playback will occur.  This View Window is the area
where you will see playback, and because the area is smaller, less data is required
to display each frame on screen, so playback can be faster. This allows real-time
playback on slower machines or high-resolution clips.  Drawing a view window
is done the same way as making a selection with the rectangular marquee: select
the tool, then click-drag to define the window.  To deactivate a View Window
you have created, click outside the view window.

The Pen Tool
The Pen Tool activates Commotion’s™ rotosplining functions.  When the Pen
Tool is selected, clicking and dragging in the clip window creates new keypoints
on the active path in the Rotospline palette.  Rotosplining is the creation of
paths that are defined by keypoints and a certain curvature between them.  These
paths, or splines, are used to define mattes which are in turn used to remove
certain portions of a frame or clip or to limit modifications to these particular
areas.  Splines can be used as selections (like those made with the Lasso Tool),
and these selections behave in the same way as other selections.  Splines have
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important functionality beyond that of the Lasso Tool, however.  They can be
saved and loaded later, they can be modified in various ways once they have been
created, and they can be animated across a range of frames.  For more
information on using splines and the Pen Tool, see the Rotosplining chapter in
this manual.

The Magic Wand
The Magic Wand selects all pixels adjacent to a point you click on that are
within a specified color range of the pixel selected.  Commotion™ allows you to
select the color range (“fuzziness”) in each of the components of either RGB or
HSV color space; these controls will appear in the Tool Options palette when
the Magic Wand is selected.

   The Move Tool
The Move Tool allows you to move selected pixels within the active clip.  To
use the tool, select it from the Tools palette, then click and drag in the Clip
Window; the selected pixels will be transposed from where you click first to
where you release the mouse button.

   The Paintbucket
The Paintbucket operates in the same way as the Magic Wand, except that it fills
with the foreground color the area the Magic Wand would have selected.  It can
be a valuable tool for mattes.

   The Eyedropper
This is a color selection tool that works by sampling from a pixel you choose.
When the Eyedropper is selected, Commotion™ changes the foreground color to
the color of the pixel that is clicked with the eyedropper in the Clip Window.
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   The Airbrush
The Airbrush paints like a spray-paint bottle, so that painting in an area for only
an instant is translucent and the pixels are not evenly colored (the spray
“sputters” a little bit), but the paint builds up in an area as you paint on it
longer.  This tool is helpful for creating minor color changes in an area.  You
can select the brush size and softness as with the other painting tools.  (For
information on creating brushes, see the Tool Options Palette chapter, below.)

   The Paintbrush 
The Paintbrush paints with an opacity and softness you set, so that it can vary
from a very transparent effect to a completely opaque brush.  You can select
from a palette of brushes that Commotion™ has built-on, or you can create your
own brush by.holding down Command and Option while dragging with the
mouse.  For more information about the Paintbrush and other painting tools, see
the Tool Options chapter.

  The Line Tool
The Line Tool can be used to draw straight, solid lines.  When you select the
Line Tool then click-drag; a line is drawn from the first point where you click to
the point where you release the mouse button.

   The Gradient Tool
[The Gradient Tool is inactive in this version of Commotion™]
When implemented, it will appear beneath the Paintbrush on the Tools palette.
It would be used to create a variation of color across a chosen range of pixels.

  The Eraser
The Eraser is used to erase areas of a drawing.  It acts as a paintbrush that paints
the default background color (?????).  You can select the brush size and softness
as well as the opacity of the Eraser tool.  One of the eraser options is to erase to
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the last saved version of the file, instead of erasing to the background color; this
lets you undo changes to your document by painting.  To select this option,
click on the radio button in the Tool Options palette when the Eraser tool is
selected.

  The Pencil
The Pencil functions like the Paintbrush, but with no softness on the edges of
the paint that is laid down.

  The Clone Brush
The Clone Brush allows you to clone pixels from one part of a window to
another by selecting a reference point and then painting from another point.
After defining a reference point by ..***.., the area around the reference point is
cloned around the point where you begin painting.

  The Super Clone Brush
The Super Clone Brush allows you to clone like with the regular Clone Brush,
but from other frames.  If certain frames in a clip have an unwanted object or
blemish interfering with a view but other frames do not have the blemish, the
Super Clone Brush can be used to clone pixels from the unobstructed view to
replace the blemish with a desired view.  For more information on using the
Super Clone Brush, see the

  The Blur Tool
The Blur Tool functions much like a paintbrush, but instead of adding color to
pixels, it blurs the image of the pixels around an area.  
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Dodge/Burn Tool
[not yet implemented]
The Burn tool darkens the pixels that are painted when the tool is activated.

The Dodge tool lightens the pixels that are painted when the tool is activated

 The Wire Removal Tool
The Wire Removal tool is a cross between the Line tool and the Erasor; it draws
a straight line like the line tool, but rather than drawing a line, it “erases” by
blending nearby pixels to replace the pixels in the path of the line.

   Foreground/Background Color Selections
This is the Color Selection Window that is planned for
Commotion™.  The present selection area is a square within a
larger square; click on either the foreground (smaller) or
background (larger) square to bring up the color picker.

There are three/four buttons in this color selection area.  The two larger
squares are the current foreground and background colors.  The foreground color
is the color which is painted with the paintbrushes or with the fill or stroke
commands.  The background color is the color that is “painted” with the Erasor.
You can select the foreground color by clicking on the foreground color square,
which brings up the Color Picker dialogue box, or by sampling with the
eyedropper.  You can select the background color by clicking on the background
color square, which also brings up the Color Picker dialogue box.

The small icon to the upper right of this area switches the foreground
and background colors.  The small icon to the lower left of this area changes the
foreground and background to the default colors: black in the foreground and
white in the background.
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 The Grab Tool
The Grab Tool pans the frame within the clip window.  If the active clip (at the
current zoom) is larger than the Clip Window – if the file don’t fit in ‘da winder
– the Grab Tool can be used to change the section of the frame that is shown.
This is done by clicking and dragging within the Clip Window; the first point
you click on is used as a reference point and moves to the point on the window
where you release the mouse button.

The Zoom Tool
The Zoom Tool is used for increasing the size of the clip’s display on screen.
I’m not sure it works yet, or how it works if it does.
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The Player and Info Palettes

The Player Palette
The Player palette allows you to change frames in the display.  You can move to
the beginning or end of the clip currently loaded into RAM, play the clip in the
normal or reverse direction, or advance a single frame in either direction by
pressing the icon buttons in the palette.  The a new range of frames can also be
loaded into RAM, and the Virtual Frames and Ganging function can be toggled
on or off.  The frame rate of playback can also be set using a pop-up menu.

   Beginning/End
The left-pointing icon moves the display to the first frame in the currently-loaded
clip.  The right-pointing icon moves to the last frame in the currently-loaded
clip.

   Play/Reverse Play
Pressing these buttons plays the currently loaded clip.  The left-pointing icon
plays the clip in reverse and the right-pointing icon plays the clip normally.

   Single Frame Advance
Pressing these buttons allows you to advance the clip one frame forward or
backward, right for forward and left for reverse.

   Stop
Press the square icon to stop playback.
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Frame Rate Pop-up

This pop-up menu allows you to select the frame rate (in frames per second) for
playback.  The pop-up menu has the options Max, 30, 24, and Var.  Max plays
the clip at the maximum rate possible for the size of the canvas, the
configuration of your system, and any limiting factors such as calculations or
windows covering the clip window.  In different circumstances, the max frame
rate will vary from much less to much more than the normal video frame rate of
30 frames per second (fps).  “30” plays the clip at 30 fps if possible; otherwise,
the clip is played at the maximum rate.  “24” plays the clip at 24 fps, the
standard film frame rate.  Var brings up a dialogue box requesting a keyboard
input for the playback speed; Commotion™ will play back the clip at the speed
entered or the closest rate possible.

Frame Rate Display

To the right of the Frame Rate Pop-up is a display of the frame rate for
playback.  While your clip is playing, the number in parentheses is updated to
reflect the actual frame rate in frames per second (fps).  If you change the frame
rate setting while not playing a clip, the frame rate display is changed to reflect
your setting.  It will be updated according to the actual playback speed the next
time you play back a clip.  During playback, if you selected Max playback speed
or if you set a particular playback speed that exceeds the maximum for your
system and the clip you playing, the frame rate display shows the maximum
playback speed.  Otherwise, it displays the playback speed that you selected.

   Toggling Gray Frame Border On/Off
Pressing the Frame Border button toggles between showing and hiding a gray
border around the frame in the Clip Window.  This can give a better sense of
how the frame looks and it also allows you to draw Rotosplines (see
Rotosplines chapter) that go off the edge of the frame, so you can be sure that
the mattes produced by rotosplines cover the entire edge of the frame.
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   Toggling Frame Lock On/Off
Pressing the Frame Lock button locks the In/Out frame range to the range of
Live Frames.  The In/Out frame range is automatically changed to match the
Live Frame range.  You can do this manually by dragging the In/Out frame
range slider around, but this button makes it much easier to lock the In/Out
range to the Live Frame range.

   Toggling Auto Frame Spool On/Off
Press the icon to toggle the Auto Frame Spool function on or off.  When on,
this function dictates that frames are loaded into RAM when you single-frame
advance past the end of the range of Live Frames.  This allows you to single-
frame advance through more frames than just those you have space for in RAM,
though loading these frames is a little slower than the instantaneous frame
advance with Live Frames.  The Beginning/End and Play/Reverse Play buttons
function the same way, regardless of the Auto Frame Spool setting; playback
occurs within the Live Frames.  Auto Frame Spool is also described in the Mode
Menu chapter.

Current Frame Display

This display shows the number of the frame currently displayed in the Clip
Window, and shows the first and last frame number of Live Frames.  The
number above the slider bar, in the middle, shows the currently displayed frame.
The number to the left of the slider bar shows the frame number of the first
frame in the range of Live Frames.  The number to the right of the slider bar
shows the frame number of the last frame in the range of Live Frames.  The blue
rectangle shows where the current frame is relative to the beginning and ending
of the Live Frame range.

Changing the Range of Live Frames

By clicking and dragging the top slider bar of the two in the Player palette - the
blue one - you can change the range of Live Frames for the current clip.  You
can click-drag the triangles at the ends of the slider bar to move one end of the
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Live Frame range, or you can click-drag the blue part of the slider to keep the
same number of Live Frames but change both the beginning and end of the range
of Live Frames.  You can also change the range of Live Frames by clicking on
the numbers at the left and right ends of this slider.  To set the first Live Frame
number, click on the number to the left of the Live Frame slider and type in the
number you want; to set the last Live Frame, click on the number to the right of
the slider and type in the number you want.

The In/Out Frame Range

The In/Out Frame Range is set on bottom of the two slider bars in the Player
palette - the black one.  It represents the range of frames to which all image-
processing operations are applied; all operations that affect a range of frames,
such as Math Calculations or Filters, are applied only to the frames in the
current In/Out Frame Range.  You can change this range of frames in the same
way as you change the range of Live Frames: Click on either the triangles at the
ends of the slider bar, drag the slider, or click the numbers at the ends of the
slider to enter the In and Out frames numerically.

The Info Palette
The Info palette displays the x and y coordinate (in pixels) of the cursor on the
screen.  The origin (x = 0, y = 0) is in the upper left corner.  The tip of the point
on the pointer cursor is the point to which the Info palette’s display refers.

The Info palette also displays the Red, Green, Blue, and Alpha channel’s 8-bit
values for the pixel where the cursor is located.
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The Tool Options Palette

The Tool Options palette contains all of the options for the tools selected in the
Tools palette.  All of the painting tools allow you to select different brushes, or
create your own.  Most tools also allow you to control to opacity of the tool
you are using, so that you can create subtle effects, bold effects, or anything in
between.  Different tools also have special options.  For example, the Erasor
tool can be set to erase to the background color, or to erase to the last saved
version of your clip, so that you can undo changes by painting.  All of these
controls are contained in the Options palette.

The Options palette, as well as the Color palette, consists of a number of
different sections.  For the Options palette, these sections include the opacity
slider and transfer modes pop-up, the tool-specific options, the brush control
section, and the array of default/saved brushes.
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Opacity Slider

The opacity slider at the top of the Tool Options palette sets the opacity of the
tool you are using.  If you set an opacity less than 100%, the effect of the tool
will be blended with the existing pixels.  For example, with the pencil and an
opacity setting of 100%, the pixels you paint will be turned completely to the
foreground color (as shown in the Tool and Color palettes).  If the opacity is set
to - say - 50%, then the pencil will change pixels to a color that is between the
foreground color and the previous color of the pixels.

To change the opacity setting, position the cursor over the word ‘opacity.’ A
small double arrow will appear, signifying that Commotion’s™ flying slider has
been activated.  When this double arrow is visible, you can click-drag right or
left to increase or decrease the value on the slider.

Transfer Mode Pop-up

The Transfer Mode pop-up, which appears in the upper right corner of the Tool
Options palette, allows you to set the mathematical function used to combine
pixels between the selected tool and the existing pixels.  (All tools operate pixel-
by pixel.)  Click-drag on this pop-up menu to select a different mode.  The
Normal mode is used most often; this simply paints on top of the existing
pixels, according to the opacity setting and the selected tool and color(s).  Below
is a summary of the transfer modes; the paint pixel refers to any color associated
with the selected tool (foreground color for paintbrush, for example), and the
existing pixel refers to the pixels in the clip before using the tool.

• Normal - Places the paint pixels’ color on top of the existing pixels.

• Lighter - Compares the values in each color channel  of both the
existing pixels and the paint pixels and keeps the higher value.  The
result will always be lighter than the original.  The colors will
frequently be much different from the original, since the lighter/darker
comparison is performed for each channel.
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• Darker  - Compares the values in each color channel and keeps the
lower value.  The result will always be darker than the original.  As
with the Lighter mode, the colors will often be much different from the
original due to the channel-by-channel nature of the comparison.

• Add - Adds each color channel’s values so that the result for each
pixel’s Red, Green, and Blue channels is the sum of the values for the
corresponding channel’s values in the paint pixels and the existing
pixels.

• Multiply  - Multiplies each channel’s color values (as proportions of
the maximum value) together. This always yields darker pixels than
you began with.  If either the existing pixels or the paint pixels are
black, the result is black.

• Screen - Screen functions like Add in that the result is always a lighter
color.  Screen, however, multiplies the inverse of each color channel’s
values, which basically just means that light pixels screened against
dark pixels result in light pixels.  Any pixels screened against light
pixels will result in light pixels.

Tool-Specific Options
The tool-specific options are described with the tools in the Tools Palette chapter
of the Reference Guide.  For information on the options accompanying any
specific tool, see the Tools Palette chapter.  The tool-specific options appear
near the top of the Tool Options palette, below the Opacity slider and Transfer
Mode pop-up.

As an example of the tool-specific options, the Erasor options display is shown
below.

Most of the painting tools have a “Fade __# of steps to” which allow you to set
the tool’s effect to fade out as you move the tool on the screen.

Commotion™ supports the WACOM™ pen tablet, and most paint tools also
have a checkboxes for you to select whether the amount of pressure that you put
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on the stylus (pen) corresponds to the size of the brush/tool or its opacity.
(With a mouse, the opacity and brush size are constant, according to the settings
on the palette.)

Brush Controls

Click-drag on the corresponding     word    to change the size, feather, or spacing for
the new brush.  Angle and Roundness are not yet implemented.  When the brush
in this box is the selected brush, you cannot create a brush on the fly by
pressing Command-Option like you normally can.  (The keyboard shortcut for
feathering, by the way, is dragging into the middle of your brush while holding
down control.)

Selecting a Brush from the Array of Saved Brushes

You can select a brush from the array of default brushes simply by clicking on
the one you want.  Any brush you click on then appears in the brush window in
the middle of the Brush Controls section of the Tool Options palette.  You can
make changes to the control settings of the brush you select by dragging around
the
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The Color Palette
The Color palette gives you a range of controls for selecting colors for
Commotion’s™ painting tools.  The palette is divided into three sections: The
Color Sliders section, the Scratch Pad, and the Color Swatches.

By clicking on the blue triangles on the left side of the Color palette can fold up
or drop down any of the three separate sections to show only what you need, so
that you can save screen real estate.

The Color Sliders

The color sliders function as they do in most image processing programs - you
can choose between R,G,B or H,S,V color space by clicking on their respective
radio buttons at the top of the palette.  To pick a color,  either click-drag on the

The color palette in Commotion™ is
unique because you can fold up any of
the three separate sections to only
show what you need - saving valuable
screen real estate.

The color sliders function as they do in
most image processing programs - you
can choose between R,G,B or H,S,V
color space.  To pick a color,  either
slide the pointers or manually enter a
numeric value for each.
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small triangles to slide the pointers.  You can also manually enter a numeric
value for each color value (channel) by clicking on the number window for the
desired color value then typing in a number.

The color bar at the bottom of the color slider palette displays a gradient of
colors between the foreground and background colors as currently selected.

• Foreground/Background Colors

The two larger squares represent the foreground and background colors; the
foreground color appears to be on top of the background color.  The arrow in the
upper right corner exchanges the foreground and background colors.  The small
black and white squares reset the foreground and background colors back to black
and white, respectively.

Scratch Pad
[This is inactive in the current version of Commotion™.]

The scratch pad is an area that can help you to create a custom color.  You can
use it to blend colors or test brushes.  It is basically a small, single-frame clip
that is always available to paint on.  You can save the Scratch Pad’s displays as
a PICT file or load pads you have used in the past.  The Scratch Pad pop-up
manu provides you with the following options for saving and loading scratch
pads.

     
• Reset - resets palette to default state.

• Load  - Loads the color to the palette, temporarily.

• Save - Saves the color to the palette, permanently.

• Append - **??**
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This pop-up menu on the right-hand side of the palettes is the same for both the
swatches palette and the scratch pad palette.

Swatches Palette

This palette contains the color swatches of the various default colors that
Commotion™ has pre-programmed.  By clicking on a color it will become the
active color you will be painting with.

• To add custom colors to the swatches pallet, first select the custom color as
the foreground color either by choosing it with the Color Sliders section of
the Color palette or by using the Color picker or Eyedropper.  Then hold
down the shift key to access the paintbucket, then click on the square you
would like to fill with the new color; that square is filled with the current
foreground color.

• By holding down the control key and clicking on a color, it will be deleted
from the swatches palette.

• The Swatches Palette pop-up menu in the upper right corner of the
Swatches Palette section contains the same options as appear in the Scratch
Pad section of the Color Palette.
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The Rotospline Palette
Rotosplines are paths you can create in Commotion™ for specifying shapes for
mattes.  A rotospline - or ‘spline’ - is a closed curve connected by a series of
either straight lines or bezier curves. When you render splines by pressing the
Render button in the Rotospline palette, Commotion™ creates a grayscale matte
that you can use to define foregrounds and backgrounds in when compositing
more than one clip together.

All of the rotosplining (path) tools are controlled in the Rotospline Palette.  The
palette has a list of the paths loaded for the active clip along with a series of
settings.

Spline Basics
Commotion allows you to use as many splines as desired for each clip.  When
you have multiple splines, think of them as a stack of layers -- one spline on
each layer -- with the first spline being on the top-most layer (so the way they
appear on your monitor in the Rotospline palette is the way they are stacked).

Each spline has a fill quality specification that calls for    either    the inside or the
outside of the spline to be filled (with either white or black).  Because only one
side (inside or outside) of each spline is filled, in the unfilled side, you can see
the layers below.  This allows you to create complex mattes in the way that is
most convenient for the type of shot with which you are working.

You choose the fill quality for eacy layer (spline) by clicking on the fill quality
icon directly to the right of the spline name.  Commotion fills one side of the
spline on each layer with either white or black; for the side of the spline that is
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not directed to fill with a specific color, the layers below are allowed to show
through.

If the “Merge with Alpha” option is unselected, Commotion™ uses the bottom
spline to determine the background of the splines; this bottom spline is filled as
specified, and then the opposite side has the opposite fill quality.  So if the
inside of the bottom spline is set to be filled with black, then the outside of this
spline will be filled with white, and all of the other splines stack on top of this
background.  If the Merge with Alpha option is selected, then the existing alpha
channel is used as the background and all of the spline layers are stacked on top
of the existing alpha when the splines are previewed or rendered.

When you are editing them, splines are associated with a certain clip.  You can
save splines, either individually or as a group, independent of any clip.  To do
this, choose one of the Save Layers options in the Rotospline palette pop-up
menu.  You can then load saved splines either into the same clip or into a
different clip at a later time.

Preview, Curve, and Render Buttons
These three buttons appear near the top of the Rotospline palette.  Each activates
a key feature of Commotion’s™ Rotospline functionality.

• Preview - The Preview button generates a preview of the alpha channel
according to the present splines and their configurations.  You have three
options for how to display the preview: High contrast matte, Mask overlay,
or Comp against.  These options are set in the Preview Options dialogue
box, which you bring up by selecting Preview Options from the Rotospline
palette pop-up menu in the upper right corner of the Rotospline palette.
(For more information, see the Preview Options entry under the Rotospline
Palette Pop-up Menu heading.)

• Curve - The Curve button brings up the Path Curve Editor, which allows
you to change the the way each spline is animated over time.  When you
press the Curve button, the Spline Curve Editor window appears.  (For
more information, see the Spline Curve Editor entry below.)

• Render - The Render button renders an 8-bit alpha channel according to the
settings in the Rotospline palette and the in/out frame range.  (For more
information, see the How Splines Are Rendered entry below.)
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Showing, Hiding, Coloring, and Activating Splines

•    Show/Hide Spline  - Clicking on the eyelid icon toggles between
showing and hiding the spline shape listed to the right.  When a matte is
generated from the splines, only the splines that are shown will contribute
to the matte.

• Spline Color  - You can change the color of splines by clicking on the
colored rectangle to the left of the spline name, which activates a pop-up
palette of colors to select.

• Active Spline  - Clicking on the name of a spline in the list makes this
the active spline.  The highlighted name indicates the active spline.

Splines Settings
When you have multiple splines, think of them as a stack of layers, with the
first spline being on the top-most layer.  Each spline has a group of parameters
to its right which control the edge qualities and masking function of the spline
shape.

   Fi l l  Qual i ty

Fill Quality is represented by the icons above.  From the left, the four states are:

1. Fill interior with white

2. Fill interior with black

3. Fill exterior with white

4. Fill exterior with black

When Commotion™ creates mattes - or alpha channels - from the paths defined
in the rotosplines palette, it stacks the splines on top of each other according to
the spline settings. As mentioned near the beginning of this chapter, if the
“Merge with Alpha” option is unselected, Commotion™ uses the bottom spline
layer to determine the background of the splines; this bottom spline is filled as
specified, and then the opposite side has the opposite fill quality.  So if the
inside of the bottom spline is set to be filled with black, then the outside of this
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spline is filled white, and all of the other splines stack on top of this
background..

The settings for each spline specify to fill either the interior or exterior of the
spline.  The region not filled is left unchanged by each individual path; this
allows the splines to be stacked as layers, in order to create complex mattes from
several splines.

   Feather Settings

The feather settings for each spline can be set individually and there are three
settings for the feathering.  From the left, the four states are the following:

1. Centered: The feathering is centered across the edge of the spline.

2. Inside: The feathering begins at the spline edge and feathers inward.

3. Outside: The feathering begins at the spline edge and feathers outward.

The small number box to the right of the Feather Settings icon is the feather
radius; clicking on the box allows you to enter a numerical value for the distance
over which a matte is feathered out.

Rotospline Palette Pop-up Menu
Toward the top right of the rotospline palette, there is a pop-up menu that
allows you to save and load splines as separate files and to control some of the
rotosplining options.

Here is a quick overview of the commands in the Rotospline palette pop-up
menu.  Following this list are more in-depth explanations of each command.

• Keypoints - Toggles display of keypoints on spline on/off.????
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• Layer Options -

• Preview Options - Brings up a dialogue box allowing you to see the
preview (see Preview button, above) as either a High-Contrast
(grayscale) matte, a translucent overlay of the matte over the Clip, or a
composite of the Clip on a selected background color using the preview
matte.

• Merge with Alpha - When Merge with Alpha is checked (selected),
the alpha channel generated according the the splines and their settings
is stacked on top of the existing alpha channel.

• Invert All - Inverts the grayscale matte created from your splines.

• Duplicate Layer - Duplicates the current spline and names it "copy
of (current spline name)" .  The new (duplicate) spline appears in the
list of splines in the Rotospline palette.

• Save/Load Layer - Will save/load the currently selected spline
to/from disk.  When loading a group of splines with this command,
only the first spline in the group will be loaded.

• Save/Load All Layers...  - Will save/load all the splines for a clip
as a group in a single file to disk.  When loading, the incoming group
will replace any current splines for a clip.

Layer Options
[not currently implemented in Commotion™]

Preview Options

Selecting Preview Options from the Rotospline palette pop-up menu allows you
to select from three different ways to preview the matte generated according to
your splines and their settings.  When you select Preview Options, a dialogue
box appears, allowing you to select from Hi-Con, Matte Overlay, or Comp
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Against.  The the preview (see Preview button, above) as either a High-Contrast
(grayscale) matte, a translucent overlay of the matte over the Clip, or a
composite of the Clip on a selected background color using the preview matte.

Merge with Alpha
When Merge with Alpha is checked (selected), the alpha channel generated
according the the splines and their settings is stacked on top of the existing alpha
channel in the active clip.  When you render or preview the alpha specified by
your splines and their settings, Commotion™ uses the alpha channel of the
frame currently displayed in the active Clip Window as the background.  This
allows you to edit existing alphas with splines, in addition to creating new
alphas.  One important application of this function is making garbage mattes
(rough shapes) to clean up a matte generated with one of the keyer filters.

Engaging the Merge with Alpha option turns off Commotion’s™ default
background creator.  When the Merge with Alpha option is off, Commotion
creates the background for the spline-generated matte according to the setting in
the bottom (last) spline layer;  the interior or exterior of the bottom spline is
filled according to the setting on the fill quality icon, and the opposite side
(exterior or interior) is filled with the opposite color.

Invert All
The Invert All option allows you to invert (switch between black and white) the
matte produced from your splines; the non-inverted matte is calculated first, then
inverted; this gives you both flexibility and convenience in creating different
mattes.  If you need the inverted version of a matte after creating it from several
spline layers, you can just select this option rather than figuring out the
necessary stacking order and fill qualities of your separate splines needed to
produce the inverted matte.

Selecting the Invert All option from the Rotospline palette pop-up toggles the
option on and off.  A checkmark will appear to the left of the Invert All entry in
the pop-up menu when the option is on.

Duplicate Layer
When you select Duplicate Layer from the Rotospline palette pop-up menu,
Commotion™ duplicates the current spline and names it "copy of (current spline
name)".  The new (duplicate) spline appears in the list of splines in the
Rotospline palette.  By default, the new spline is (shown, what color???)
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Saving Splines
You can save splines by selecting either the Save Single Layer or the Save All
Layer option in the Rotospline palette pop-up menu in the upper right corner of
the Rotospline palette.  The Save Single Layer command allows you to save the
currently active spline (indicated by black highlight).  The Save All Layers
command saves all of the splines currently listed in the Rotospline palette.  Both
of these Save commands are otherwise the same; each brings up a standard Save
dialogue box and each saves the spline(s) in a Commotion™ Spline File????.

Loading Splines
You can load Commotion™ spline files by selecting either the Load Single
Layer of the Load All Layers command from the Rotospline palette pop-up
menu in the upper right corner of the Rotospline palette.  The splines you load
can be from any clip; Commotion™ has a number of options for loading splines
from a different sized clip (see Dynamic Scaling of Splines, below.)  Selecting
the Load Single Layer command allows you to add a saved spline to the list of
splines in the Rotospline palette; when you choose a spline file in the Open
dialogue box that appears, the new spline appears at the bottom of the stack of
spline layers.  When loading splines, Commotion™ can read only
Commotion™ spline files, since no other programs have spline files.

• Dynamic Scaling of Splines

When loading a path that originated from a clip of different dimensions than the
current clip, Commotion can adjust the proportions/scale of the splines
accordingly.  This allows you to quickly create a spline at a reduced resolution,
and then open up the path in the full resolution clip for fine tuning.

The settings in the Load Spline Options???? dialogue box will resize the spline
information according to your selection.

• Keep Same - Leaves the spline(s) the same size (in terms of pixels).
The spline or group of splines is placed in the top left corner of clip
(Commotion’s standard X-Y origin).

• Keep Same, Centered - Leaves the spline(s) at same size, centered
in the clip that you are loading them into.

• Adjust Size + Ratio  - Scales the spline(s) to fit the new clip size,
stretching the aspect (length/width) ratio if necessary.
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• Adjust Size, Keep Ratio  - Scales the spline(s) to fit, maintaining
the original aspect ratio.  If the aspect ratio is different between the clip
and the splines being loaded, Commotion™ sizes the spline layer(s) so
that they fit entirely within the new clip.

Painting Splines and Making a Selection
By clicking on the icons at the bottom of the Rotosplines palette, splines can be
used as a fill, stroke, or selection boundary:

   Stroke

Click on the Stroke icon to stroke the current selected path using the current
Paintbrush Tool Options (opacity, brush shape, transfer mode, etc.).

   Fi l l

Use the Fill icon to fill a spline shape with the current foreground color. (This
can be useful when touching up mattes or imperfections in color/luminosity
areas that will be keyed latter.)

   Make Selection

Makes the currently viewable splines into a selection for the current frame.  This
selection behaves the same as selections made with the Magic Wand, Marquee,
or Lasso Tools.  (See Selections in the Edit Menu chapter and see the entries in
the Tools Palette chapter for these specific tools.)

New and Delete Spline Icons
In the lower right corner of the Path Tools palette are three tool buttons for
working with splines:

   New Spline

Clicking creates a new spline.  It will appear at the bottom of the list of existing
splines.  There is no shape in the clip window for the spline until you draw one
with the Pen tool.

   Delete Spline

Clicking this icon deletes the currently active spline.  (The active spline is the
spline with its name highlighted in black in the Rotospline palette.)



82

Naming Splines
To rename a spline, double click on its current name.  A dialogue box will
appear, in which you can type the new name for the spline.

Drag Re-Ordering of Splines
Because splines behave as layers stacked on top of one another, the order of the
splines has a large impact on the alpha channel that results when it is rendered
from the splines.  To make it easy to change the order of your splines, you can
move a spline to a new location in the stack of layers by clicking on the spline
you wish to move and dragging it to the place in the stack where you want it.
While you are dragging, a bold line will appear below the line where the new
spline will appear when you release the mouse button.

Spline Curve Editor
The Spline Curve Editor allows you to add, subtract, and move spline
keyframes.  Keyframes are frames for which the location and shape of a spline is
set -- not interpolated.  The splines’ location and shape for each non-keyframe is
interpolated based on the keyframe preceding and the keyframe following each
non-keyframe.  This interpolation is ___(mathematical method, whether it can
be varied???).  The interpolation applies to the location of each spline keypoint
(the squares that appear when you click with the pen tool), as well as the bezier
handles for each keypoint, if applicable.

To access the Spline Curve Editor, press the Curve button on the Rotospline
palette.  This brings up the Spline Curve Editor window.

The Spline Curve Editor window works much like the Time Adjust window; it
shows a plot of the currently set keyframes

How Splines Are Rendered
When you press the Render button in the Rotospline palette, a dialogue box
appears, allowing you to select the destination for the 8-bit alpha channel that
will be rendered according to the current splines and their settings.  When you
press OK, Commotion™ writes the a new alpha channel to the selected
desination for all of the frames in the In/Out frame range.

The three options available for the rendering desination are New Clip, To Disk,
and To Alpha of Current Clip.  New Clip and To Disk both render the alpha to a
new sequence of 8-bit grayscale PICT.  New Clip automatically opens the new
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file and loads a range of frames.  To Disk renders the sequence of new files to
disk without opening them as a clip.  To Alpha of Current Clip renders the
grayscale matte to the alpha channel of the current clip.  (If you had more than
one clip open, you would have to make sure that the active clip window was the
one for which you wanted to render the matte.  This usually will not be
confusing, though, because the Rotospline palette shows the splines for the
currently active clip, so when you change clips, the Rotospline palette changes
its display.)
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The Clone Source Palette

The Clone palette is used to control the clone source for Commotion’s™ Super
Clone Brush. The Super Clone Brush is a tool that allows you to clone (copy)
pixels from any location in any frame of any open clip.  If one frame has a flaw
but another does not, and the flaw is set on an area that does not change from
one frame to the next, then you can clone pixels from the good frame to remove
a flaw.  You can clone from clips that are different sizes (in terms of pixel
dimensions); Commotion™ lines up the upper left corner of the clone source
with the upper left corner of the target by default and you can set an X-Y offset
from there.

   This tool can be a great help when you wish to fix a problem with a
frame and there is another similar frame that does not have the same problem.
The capacity to clone pixels frome one area to another is a very useful ability for
touching-up photorealistic images.  This way, subtle variations of color can be
maintained. Cloning is also important if you are using footage at a low color
depth that has been dithered; simply painting onto a dithered image is very
difficult if the image is meant to look at all realistic.  The Clone tools allow the
moving picture artist -- you -- to paint out unwanted items such as boom
microphones or to remove dirt or blemishes from a shot.

The Clone palette allows you to select the sources for cloning with the Super
Clone Brush.  You can set up to four different clone sources at one time.  Each
source is specified by the name of the clip, the relative and absolute frame offset,
and the X-Y offset.
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Selecting the Clone Source

   The paintbucket icon at the left of the Clone palette shows the selected
clone source.  The four rows in the middle of the clone source palette each
corresponds to one of the four clone sources you can set.  To select a different
source, click on the row of the source you want, in the column where the
paintbucket is.

Name of the Source Clip

For each of the four possible clone sources, you can select the source clip by
clicking on the source name pop-up.  When you hold down the mouse button on
one of the source name pop-ups, Commotion™ displays a list of the open clips.
Select the clip for each clone source by dragging to the name of the clip you
want as your source.

Frame Box

The Frame Box contains three settings that can be applied independently to each
clone source: The Frame Lock, The Relative Frame Offset, and the Abxolute
Clone Source Frame.

Frame Lock

The Frame Lock checkbox allows you to turn on or off the Frame Lock option,
which...DOES SOMETHING THAT I DON’T KNOW ABOUT...
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Relative Frame Offset   fixfixfixfixfixfixfixfix
The “Rel” heading refers to the relative frame offset.  If this value is zero, the the
Super Clone Brush clones from the same frame number in the source clip as the
current active clip is displaying.  For example, if the clip that you are cloning to
(which will be the active clip) is displaying frame number 5 and the relative
frame offset is 0, then the Super Clone Brush will clone from frame number 5 in
the source clip.

You can set the relative frame offset to a different value to use an earlier or later
frame as the clone source.  If you set the relative frame offset to a negative
number, an earlier frame is used as the clone source.  For example, if the relative
offset is set to -2 and the clip that you are clonging to is displaying frame
number 5, then the Super Clone Brush will clone from frame number 3  (5 - 2)
in the clip selected as the clone source.  If you set the relative frame offset to a
positive number, a later frame (relative to the frame number in the destination)
will be used as the clone source.

To change the relative frame offset, click/double click on the current setting for
the offset.  This brings up a dialogue box that allows you to enter the frame
number and click a radio button to determine whether you are using a relative or
absolute frame reference.

X-Y Offset

By default, when you use the Super Clone Brush, you clone from the same
location in the frame being used as the clone source and in the active clip -- the
cloning destination.  This is because one of the most common uses for the
Super Clone Brush is to copy pixels between two frames with the same content
aside from a certain moving element, or between two pieces of footage shot with
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a motion control camera so that the content is largely identical.  However, you
can set an X-Y offset for each clone source so that you can clone from different
parts of the clone source frame from where you are painting in the active clip.

The X-Y offset values in the Clone palette show the offset of the clone source
relative to the clone destination (in the active clip).  X-Y (horizontal - vertical)
values in Commotion™ are measured from the upper left corner of a frame,
increasing as you move down and to the right.

To set the X-Y offset, you can click on the X or Y offset value you want to
change, which brings up a dialogue box that allows you to set the X-Y offset
numerically.  You can also hold down Shift -- showing an Onion Skin overlay
of the clone source on the target -- and click-drag in the Clip Window to move
the Onion Skin overlay around.  The X-Y offset will be set accordingly.

Cue Button

Using the Super Clone Brush

   To use the Super Clone Brush, set up a clone source in the clone palette
and select the Super Clone Brush tool from the Tools palette.  Make sure the
clone source you set up is selected in the Clone palette.  Also select a brush
from the Tool Options palette or create a new brush; like most painting tools,
the Super Clone Brush obeys the brush settings in the Tool Options palette.
(For how to select or create brushes, see the Tool Options Palette chapter.)
Then paint in the active clip window to clone pixels into the window.


